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What RBC Pages Should Be Submitted?

For year-end 2017 property/casualty (P/C) risk-based
capital (RBC), hard copies of pages PR0O01 through
PRO035, as well as PR038 and PR039, should be submit-
ted to any state that requests a hard copy. Beginning with
the year-end 2011 RBC, a hard copy was not required to
be submitted to the NAIC, but a portable document
format (PDF) file representing the hard copy filing is part
of the electronic filing with the NAIC.

Type 7 Affiliated Investments

As a result of the adoption of agenda item 2014-29-P by

the Capital Adequacy (E) Task Force at the 2016 Fall

National Meeting, the calculation of the RBC charge

for the ownership of investment affiliates (affiliate Type

7) will be simplified by applying a fixed 22.5% times

the book-adjusted carrying value (BACV) of the,
common stocks, preferred stocks and bonds.

Operational Risk

As a result of a technical issue that was presdg
during the June 28 Capital Adequacy (E) Task Fo

conference call, implementation of a risk §factor for
Operational Risk has been deferred for at a year.

The Task Force adopted agenda item 29%8%3-@yat the
Spring National Meeting and mogified @ June 28
conference call. At the Spring orndighageting, the

Task Force in essence voted to “ ive” for 2017
reporting by adopting the tural charige to remove
the informational only paMove the *“add-on”
approach for basic operaiy®Weh r1 Page PR032. On
its June 28 confergnce ¢ @ lask Force adopted the
operational risk 1 asgior pages PRO03 and
PR032, but ce the recommended RBC
charge from r 2017 to allow the Opera-

tional Risk (E) group to address the technical
concerns raised.

Stop Loss

As a result of the adoption of agenda item 2016-17-CA
by the Capital Adequacy (E) Task Force at the Spring
National Meeting, a tiered factor approach will be
applied to Line (9) on page PRO19. A footnote was
added to apply a factor of 0.350 to the first $25,000,000
in stop loss premium and apply a factor of 0.250 to the
remaining premium in excess of $25,000,000.

Money Market

Mutual Funds

As a result of the reclassification o ney rvarket mutual

funds (MMMFs) to cash equi
Accounting Principles (@ Wi
Adequacy (E) Task Force aglo5%
CA at Spring Natlonal [

on their own line o

and subtracted from t

Statement Source

Catastr

1. Catast
risk m|

the Statutory
roup, the Capital
agenda item 2016-15-
MPFs will be isolated
aneous Assets schedule
equivalents. The Annual
E Pt 2 C7 L8599999.

ng identified as the most significant
e RBC formula, will finally become

ormula for 2017 reporting after more than a

f
dem& lopment. This is taking place as a result of
d

of agenda item 2016-07-CR by the Capital

y (E) Task Force at the Spring National Meeting.

@e the proposal for the detail of the changes.

clarifying change was made to the interrogatory that
provides insurers with little or no exposure to earthquake

or hurricane risk

to obtain exemption from reporting

catastrophe risk. As a result of the adoption of agenda

item 2016-11-CR

by the Capital Adequacy (E) Task

Force at the Fall National Meeting, the revised interroga-
tory will separate the earthquake and hurricane risks into
two sections so that a company has to complete this inter-
rogatory if either the earthquake or the hurricane RBC

charge is zero.
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Unaffiliated Common Stock Money Market Mutual Funds

As a result of the adoption of agenda item 2016-15-CA, the Capital Adequacy (E) Task Force adopted agenda item
2017-06-CA on its June 28 conference call. To avoid double counting MMMFs in both cash equivalents and common
stock, the factor was changed to 0.00 in Line (16) on page PROO7. The instructions also were revised to reflect the
change.

Supplemental Benefits within Stand-Alone Medicare Part D Coverage

As a result of the adoption of agenda item 2016-16-CA by the Capital Adequacy (E) Task Force
Meeting, the factor for Supplemental Benefits within Stand-Alone Medicare Part D Coverage (§lge
and Line (10.2) were increased to 0.500 and will be applied to claims incurred.

Spring National
9, Line (3.2)

New Underwriting Risk Factors 7S

On its June 28 conference call, the Capital Adequacy (E) Task Force adopted the nm;he Underwriting Risk
r

page PRO17 Underwriting Risk—Reserves Line (4) and PR018 Underwriting Risk— I premium Line (4) .

Unlike the Line (1) industry average factors that are updated annually, these facto

rs@ad not been updated since 2010
reporting. An updated review of the factors using the revised methodology was le

by the American Academy of
isk-Based Capital (E) Working
apped) in the report of 2017 Property
he factors will be re-evaluated again

| PRO17 Underwriting Risk — Reserves riting Risk — Net Written Premiums

Line (4), Industry Losses & Loss Adjustment Expense Rati‘_ ), Industry Losses & Loss Adjustment Expense Ratio
2016 2017 2016 2017

Col. Line of Business Factor Line of Business Factor Factor
1) H/F 0.201 HIF 0.937 0.927
@) PPA 0.192 PPA 0.969 0.969
©) CA CA 0.988 1.005
(4) wcC (4) wcC 1.033 1.044
(5) CMP ®) CMP 0.921 0.892
(6) MPL Occurrence (6) MPL Occurrence 1.822 1.778
) MPL Clms Mad () MPL Clms Made 1.092 1.103
(8) 8) SL 0.904 0.898
) (9) oL 1.042 1.027
(10) (10) Fidelity / Surety 0.883 0.875
(11) (11) Special Property 0.941 0.907
(12) [ AutoP (12) | Auto Physical Damage 0.843 0.836
(13) | Other (credit A&H) 0172 0.186 (13) Other (credit A&H) 0.893 0.906
@ | P |0, | [0 e | e | s
(15) INTL 0.327 0.336 (15) INTL 1.169 1187
(16) | REIN. P&F Lines 0.286 0.304 (16) REIN. P&F Lines 1.349 1.223
) REIN. Liability 0769 T 17) REIN. Liability 1507 1.449
(18) PL 0.643 0.688 (18) PL 1.214 1.228
(19) Warranty 0.325 0.338 (19) Warranty 0.883 0.875
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New Industry Average Risk Factors — Annual Update

On its June 28 conference call, the Capital Adequacy (E) Task Force adopted the annual update of industry average

development factors:

Editorial Change

The Column (4) lgadi
Covariance Before wpi
Line (73), res

ciation of Insurance Commissioners

© 2017 National

Property and Casualty Risk-Based Capital Newsletter
Volume 21.1. Published annually or whenever needed by
the NAIC for insurance regulators, professionals and
consumers.

PRO017 Underwriting Risk — Reserves | PRO18 Underwriting Risk — Net Written Premiums
Line (1), Industry Average Development Factors Line (1), Industry Average Loss and Expense Ratios
2016 2017 20 2017
Col. Line of Business Factor Factor Col. Line of Business Fattor Factor
@ H/F 0.972 0.984 (1) H/F 0.688
2 PPA 1.002 1.012 ) PPA 0.800
(3) CA 1.015 1.034 (3) CA 0.706
4 wC 0.971 0.971 (4 wc 0.751
(5) CMP 0.942 0.956 (5) CigdP 0.647
(6) MPL Occurrence 0.841 0.868 (6) MP 0.777
@) MPL CIms Made 0.822 0.854 ) |& ade 0.691 0.722
(8) SL 0.919 0.926 (8) 0.572 0.567
9) oL 0.929 0.952 oL 0.618 0.629
(10) Fidelity / Surety 1.035 1.016 ) delity / Surety 0.464 0.430
(11) Special Property 0.973 0982 ¢ Special Property 0.559 0.555
(12) | Auto Physical Damage 0.995 1.0 ( Auto Physical Damage 0.711 0.727
(13) Other (credit A&H) 0.986 9081 3) Other (credit A&H) 0.699 0.712
(14) Fmangiglral\:tc;rtgage 0.853 0 (14) Finangzglrah:&rtgage 1.293 1.175
(15) INTL (15) INTL 0.607 0.565
(16) REIN. P&F Lines (16) REIN. P&F Lines 0.512 0.459
(17) REIN. Liability (17) REIN. Liability 0.600 0.609
(18) PL (18) PL 0.684 0.670
(19) Warranty (19) Warranty 0.611 0.645

@ R003 Detail for Affiliated Bonds and Stocks were updated to “Affiliate’s RBC After
Risk”, and the line references for life and P/C were changed to Line (67) + (70) and

Direct correspondence to: Eva Yeung, RBC Newsletters,
NAIC, 1100 Walnut Street, Suite 1500, Kansas City,
MO  64106-2197. Phone: 816-783-8407. Email:
eyeung@naic.org.

Address corrections requested. Please mail the old
address label with the correction to: NAIC Publications
Department, 1100 Walnut Street, Suite 1500, Kansas
City, MO 64106-2197. Phone: 816-783-8300. Email:
prodserv@naic.org.
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UNDERWRITING AND INVESTMENT EXHIBIT - PREMIUMS WRITTEN PR035

(1) Did your company write Accident and Health Insurance in 2016?

If answer is yes, please complete Column 2, 2016 Net Premiums Written.
(2) Did your company write Accident and Health Insurance in 2015?

If answer is yes, please complete Column 3, 2015 Net Premiums Written.
(3) Were the total net Premiums written zero in 2016?
(4) Were the total net Premiums written zero in 2015?

For all companies,enter net premiums written in all Columns, Line 1 through Line 34.

12. Earthquake
13.  Group Accident and Health

14. Credit Accident and Health (group and individual)
15.  Other Accident and Health
16. Workers' Compensation

(@) (@3] (©)]
2017 2016 2015
Net Premiums Net Premiums et Premiums
Line of Business Written Writte Written

1. Fire 0 XXX
2. Allied Lines 0 ’ XXX
3. Farmowners Multiple Peril 0 XXX
4. Homeowners Multiple Peril 0 XXX
5. Commercial Multiple Peril 0 XXX
6. Mortgage Guaranty 0 XXX
8. Ocean Marine XXX
9. Inland Marine XXX
10. Financial Guaranty XXX XXX
11.1 Medical Professional Liability - Occurrence XXX XXX
11.2 Medical Professional Liability - Claims-Made XXX XXX

XXX

17.1 Other Liability - Occurrence

XXX

XXX

34. Aggregate Write-Ins fo, of Business

. TOTALS

© 1994-2017 National Association of Insurance Commissioners pross

XXX

XXX

0

0
17.2 Other Liability - Claims-Made ’ 0 XXX XXX
17.3 Excess Workers' Compensation 0 XXX XXX
18.1 Products Liability - Occurrence 0 XXX XXX
18.2 Products Liability - Claims-Made 0 XXX XXX
19.1, 19.2 Private Passenger Auto Liability 0 XXX XXX
19.3,19.4 Commercial Auto Liability 0 XXX XXX
21. Auto Physical Damage 0 XXX XXX
22, Aircraft (all perils) 0 XXX XXX
23. Fidelity 0 XXX XXX
24. Surety 0 XXX XXX
26. Burglary and Theft 0 XXX XXX
27. Boiler and Machinery 0 XXX XXX
28. Credit 0 XXX XXX
29. International 0 XXX XXX
30. Warranty 0 XXX XXX
31. Reinsurance Property 0 XXX XXX
32. Reinsurance Liability 0 XXX XXX
33. Reinsurance Financial Lig 0 XXX XXX

0

0

10/20/2017
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Property and Casualty
Risk-Based Capital Forecasting
Spreadsheet Instructions

The property and casualty RBC forecasting CD-ROM contains a spreadsheet that calcula BC using
the same formula presented in the 2017 NAIC Property and Casualty Risk-Based&api eport
Including Overview & Instructions for Companies. (A hardcopy of this booklet is nmig§led with the
forecasting CD-ROM or is available for download from the NAIC Publication Depar,

L 4
These forecasting spreadsheets can be used to check RBC results throughou r an early look
at RBC results before the RBC vendor filing software may be availab r valuate “what-if”

scenarios.

WARNIN

The RBC forecasting spreadsheet CANNO NX to meet the year-end
risk-based capital electronic filing req® t. Risk-based capital filing
software from an annual statement endor should be used to
create the electronic filing. If the fgre worksheet is sent instead of an
electronic filing, it will not be acc& d the RBC will not have been

filed.

User Requirements About the File

* A Microsoft  Windows® _of The spreadsheet Forecast P&C 2017 08
Microsoft ~ Excel 20 patible _18.xIsm was created in Microsoft Excel. The
versions). spreadsheet can be used with Microsoft Excel

* Five megabytes of hard a version 14.0 or higher. The spreadsheet

* A good undergtanding spreadsheet includes menus for use in navigation between
software. pages and for printing.

. hy
Installation fro @ ROM The RBC spreadsheet above follows the 2017

NAIC Property and Casualty Risk-Based
Capital Report Including Overview and
Instructions for Companies formula pages. A
copy of the instructions and blank are included
with the CD ROM to assist in the completion
of the forecasting file.

To install the @pceadsneet files, start Windows
the CD-ROM drive where
the forecafing spreadsheet is located.

Copy and Paste the Forecast P&C 2017 _
08_18.xIsm file in the directory where you
would like the file to be saved.

© 1994-2017 National Association of Insurance Commissioners
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Usage
1. Open the Forecast P&C 2017 _08_18.xIsm file.
2. Enter data as described in the following sections and examine the results.
3. Save any changes to the spreadsheets using the “Save” command from the “File” menu.

Please Note

In certain versions of Excel, the user may receive the following message when the forgtast ile
is opened:

E/] Security Warning Some adtive content has been disabled. Click for more details. |

If this is the case, the user would need to click on the “Enable Content”

To change the Excel security level, go to the Developer tab, in the
Security. In the Macro Settings, select the security option.

L 4
Macro Settings \

ﬂ r_"ﬂ ﬂ Record Macro Disable ithout ndtification

: —3Z el s Rajative References @ Disable 3 i ificatic

'E'f'-“" Macrg Dis | pmacro™ept digitally signed macros

asic
i ‘En\ macs (not recommended; potentially dangerous code can run)

Data Entry
The spreadsheets have been color-coded use.

» Blue-shaded cells with a blue #nt are data elements that tie directly to the 2017 property and
casualty annual statement (i®Q, vendor link items). This data can be found in the company
annual statement filing.

* Red-shaded cells
annual statement 4
records as noted in

*  White-shade lls witha black font are data elements calculated automatically by the
spreadsheet. cells are protected.
e

Yellow-shasmg e data elements that must be entered using a separate input worksheet.
i % Il will automatically take the user to the input worksheet. Data input into the
get will feed automatically to the main page.

unique features of the forecasting spreadsheet is its ability to perform what-if
calculations. Because the formula is implemented through the Excel spreadsheet, the user is able
to run various scenarios by adjusting the book/adjusted carrying value, amount or statement value
to analyze the effect such changes would have on the company’s overall RBC ratio based on the
RBC factors and covariance.

© 1994-2017 National Association of Insurance Commissioners
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Saving and Exiting

To exit the program, simply click the n in the upper right corner of the file or choose the
“Exit” option from the “File” menu. The spreadsheet program will prompt to save any files that
have been changed.

» Answer “yes” to save any changes, such as data input or formula changes.
» Answer “no” if saving is not desired. Warning: This will ignore any and all other ch

Printing

A print menu was added to aid in printing for Excel users. Click on eacﬂ&n the page
bu

name for the individual pages that are desired to be printed. Then selygipt for “Print
Selected Pages.” Select the “Reset” button any time it is desired to hav

s deselected.
Individual boxes can also be deselected by clicking on them.
RBC Forecasting Tips

@ le is available. The NAIC

¥ng or is otherwise defective.
ts sé@ion before beginning. In some
ious affiliates themselves.

statement instructions nearby and

1. Make sure the CD-ROM is retained so a back-up copyﬁf h
will not replace the CD-ROM unless it was damaged dupi

2. Gather information required for the affiliated inyest
instances, information will need to be gathered fr

3. Keep a copy of the NAIC annual statement bla
refer to them as needed.

4. Keep the copy of the RBC Overview ancﬂ ﬁtr ongat the computer to be used as a reference

while filling out the spreadsheet. Thg lows the RBC Overview and Instructions
formula pages exactly.

5. Make a list of questions while
saving both parties time.

6. When leaving voicemail messages, makesthe question as specific and detailed as possible. We
will then be able to call backetith the answer, saving time spent on the phone. Please leave a
phone number or email addeess,; qad we will get back with an answer as soon as possible.

e spreadsheet. Then call the NAIC staff once,

Questions and Supp

If problems are encounteretiyplease refer to the RBC Overview and Instructions booklet and/or
the Forecasting adsheet Instructions. However, if there is still a question, contact the NAIC.

For questio ining to annual statement references, insurance accounting questions or
formul SeONs, guntact Eva Yeung.

age related questions (loading the product, etc.), contact the NAIC Help Desk.

Importalg Contact Information

» Formula questions: Eva Yeung, (816) 783-8407 or eyeung@naic.org.

e Computer questions: NAIC Help Desk, (816) 783-8500 or help@naic.org.

o Annual statement questions: NAIC Financial Reporting Questions Help Line, (816) 783-8400.
» Questions on publications: NAIC Publications, (816) 783-8300 or prodserv@naic.org.

© 1994-2017 National Association of Insurance Commissioners
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NAIC

National Association of Insurance Commissioners

The National Association of Insurance Commissioners
(NAIC) is the U.S. standard-setting and regulatory support
organization created and governed by the chief insurance
regulators from the 50 states, the District of Columbia and five
U.S. territories. Through the NAIC, state insurance regulators
establish standards and best practices, conduct peer review,
and coordinate their regulatory oversight. NAIC staff supports
these efforts and represents the collective views of state
regulators domestically and internationally. NAIC members,
together with the central resources of the NAIC, form the
national system of state-based insurance regulation in the U.S.

For more information, visit www.naic.org.
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